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保証 9（b）

当社では、ソフトウェア製品を提供する目的で使用されているメディア、およびそのメディア上のプログラムのエン
コードにおいて、出荷の日から 3 か月間、材料およびその仕上がりについて欠陥がないことを保証します。この保
証期間中にメディアまたはエンコードに欠陥があることが判明した場合、当社では、当該欠陥メディアの交換品
を提供します。ソフトウェア製品を提供する目的で使用されているメディアを除き、本ソフトウェア製品は、明示
的保証または暗示的保証を問わず何等保証のない "現状有姿" のまま提供されています。当社では、本ソフト
ウェア製品に含まれる機能がお客様の要求を満たすこと、プログラムの動作が中断されないこと、エラーが発生し
ないことのいずれも保証いたしません。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただきます。お客様から通知を受けた後、妥当な期間内に材料およびその仕上がりに欠陥がない交換品を提
供できない場合、お客様は、本ソフトウェア製品のライセンスを終了して本製品とその関連材料を返却し、お客
様が既に支払った代金を払い戻すことができます。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥メディアの交換またはお客様が支払った代金払い戻しを行う当社の責任は、本保証の不履行についてお客様
に提供される唯一の排他的な法的救済となります。間接損害、特別損害、付随的損害または派生損害については、
当社およびそのベンダは、損害の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性
に関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があり
ます。 システムの操作に関する警告や注意事項については、他製品のコンポーネントのマニュアルに
ある安全に関するセクションをお読みください。

火災や人体への損傷を避けるには

接続と切断は正しく行ってください。 プローブ出力を測定機器に接続してから、プローブを被測定
回路に接続してください。 被測定回路にプローブの基準リードを接続してから、プローブ入力を接続し
てください。 プローブ入力とプローブの基準リードを被測定回路から切断した後で、プローブを測定
機器から切断してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべて
の定格とマーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マ
ニュアルを参照してください。

共通端子を含むどの端子にも、その端子の最大定格を超える電位をかけないでください。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作
させないでください。

障害の疑いがあるときは動作させないでください。 本製品に損傷の疑いがある場合、資格のあ
るサービス担当者に検査してもらってください。

回路の露出を避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに触れ
ないでください。

湿気の多いところでは動作させないでください。

爆発しやすい環境では動作させないでください。

製品の表面を清潔で乾燥した状態に保ってください。

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 「警告」では、怪我や死亡の原因となる状態や行為を示します。

注意： 「注意」では、本製品やその他の資産に損害を与える状態や行為を示します。
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まえがき

TDSHT3 HDMI コンプライアンス・テスト・ソフトウェアは、当社のオシロスコープで動作する HDMI（High
Definition Multimedia Interface）コンプライアンス・テスト・ソリューションです。このソフトウェアを使用する
と、HDMI 物理層の検証とコンプライアンス・テストを実行できます。

注： TDSHT3 には、2 つのアプリケーションが用意されています。1 つは CTS 1.2a 仕様をサポートするバー
ジョン（TDSHT3）で、もう 1 つは CTS 1.3b1 仕様をサポートするバージョン（TDSHT3v1.3）です。両者をオシ
ロスコープに読み込んで混在させることもできますが、一度に実行できるのは 1 つのアプリケーションのみ
です。CTS1.2a 仕様をサポートしている TDSHT3 の詳細については、『TDSHT3 HDMI クイック・スタート・
ユーザ・マニュアル』（当社部品番号 071-1961-01）を参照してください。

主要な機能
HDMI 1.3a 規格とテスト仕様（CTS バージョン 1.3b1）に準拠することにより結果の信頼性を保証

ソース、シンク、およびケーブル・デバイスに対する広範囲なテストにより、規格についてのすべて
の妥当性を検証

確度の高い測定技術を使用した、正確なソース・テスト

機器設定の非線形性を除去するクローズドループ測定を使用した、信頼性の高いシンク・テスト

信号ソースのリモート・コントロールによる、自動化されたシンク・テストとケーブル・テスト

自動マスク調整、測定、および合格または不合格の通知

統計分析とマスク・マージンによる詳細な分析

1 つのボタン操作による複数のテストの実行

1 つのボタン操作による CSV 形式のサマリと HTML 統合レポートの作成

精密なテスト・フィクスチャ、信号ソース、および TDR を使用する、完全なコンプライアンス・ソリューション

2 つのレーンでソース・シングルエンドのテストを実行可能

4 つのすべてのレーン（Clock、Data0、Data1、および Data2）でソース差動および Cable Eye ダイ
アグラムのテストを実行可能

iv TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル
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マニュアル
このマニュアルでは、TSDHT3 ソフトウェアのインストールと基本的な操作について説明します。詳細につい
ては、オンライン・ヘルプを参照してください。この製品では、次の資料が利用できます。

TDSHT3 オンライン・ヘルプ

Start > Programs > TekApplications > TDSHT3v1-3 > Help

TDSHT3 オンライン・ヘルプ
（PDF）

『TDSHT3 Quick Start User
Manual』、英語（PDF）

『TDSHT3 クイック・スタート・
ユーザ・マニュアル』、日本語
（PDF）

『TDSHT3 クイック・リファレ
ンス・カード、ソース・テスト』
（PDF）

『TDSHT3 クイック・リファレ
ンス・カード、シンク・テスト』
（PDF）

C:\ProgramFiles\TekApplications\
TDSHT3v1-3\Manuals www.tektronix.com/manuals

インストール・マニュアル：
『Windows ベースのオシロス
コープ上で動作するオプショ
ン・アプリケーション・ソフト
ウェア』

ソフトウェアのアップグレード
ソフトウェアは定期的にアップグレードできます。特定のオシロスコープ・モデルとシリアル番号に対して有
効なオプション・キーを所有している場合にのみ、ソフトウェアが動作します。

アップグレードを確認するには：

1. www.tektronix.com/software にアクセスします。

2. 製品名（TDSHT3）を入力します。

TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル v
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ソフトウェアのインストール

ソフトウェアのインストール

TDSHT3 ソフトウェアは、当社のオシロスコープにインストールする必要があります。

4 チャンネル機能を使用して、4 つのすべてのレーン（Clock、Data0、Data1、および Data2）でソース／ケー
ブルのテストを実行できます。測定が完了すると、すべてのチャンネルに対する包括的なテスト・レポートが
生成されます。DPO シリーズ・オシロスコープのリアルタイム機能が使用され、テスト時間が短縮されます。
対応しているオシロスコープは次のとおりです。

DPO70804 型および DSA70804 型（推奨）

DPO71254 型および DSA71254 型

DPO71604 型および DSA71604 型

DPO72004 型および DSA72004 型

このバージョンの TDSHT3 ソフトウェアは、次のオシロスコープでも動作しますが、4 チャンネル機能は
サポートされません。

TDS7254 型および TDS7254B 型

TDS7404 型および TDS7404B 型

CSA7404 型および CSA7404B 型

TDS7704B 型

TDS6604B 型

TDS6804B 型

TDS6124C 型

TDS6154C 型

DPO70404 型および DSA70404 型

DPO70604 型および DSA70604 型

インストールする前に
オシロスコープには TekVisa をインストールしておく必要があります。TekVisa をお持ちでない場合
は、Tektronix Web サイトの Software Upgrades と同じページからダウンロードできます。 (v ページ 「ソ
フトウェアのアップグレード」 参照)。

ソフトウェアをインストールする前に、製品ソフトウェア CD に含まれている Readme.txt ファイルをお
読みください。

TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル 1



ソフトウェアのインストール

インストール
1. すべてのアプリケーションを終了します。

2. オシロスコープの CD ドライブに製品ソフトウェア CD を挿入します。

3. インストール・ウィザードに従って、インストールを実行します。アップグレードの場合は、新しいバージョ
ンをインストールする前に既存のソフトウェアが自動的に削除されます。

4. ソフトウェア・ファイルは、C:\Program Files\TekApplications\TDSHT3v1–3 にインストールされ
ます。

オシロスコープへの接続
テストごとに、個別の機器設定とテスト・アダプタが必要です。テストするデバイスとテスト機器をオシロ
スコープに接続する方法については、接続ペインの More をクリックしてください。実行するテストに
応じて、次のテスト・アダプタが必要になります。

Efficere Technologies 社製品の ET-HDMI-TPA-R（推奨）

Efficere Technologies 社製品の ET-HDMI-TPA-P（推奨）

以下のテスト・フィクスチャは、限られた HDMI テストにのみ使用できます。

当社 HDMI TPA-P-DI（Eye Diagram を除く差動ソース・テスト用）

当社 HDMI TPA-P-SE（シングルエンド・ソースのテスト用）

当社 HDMI TPA-P-TDR（TDR テスト用）およびソース・テスト（ Eye Diagram ）

当社 HDMI TPA-R-DI（ケーブル・テストおよびシンク・テスト用）

当社 HDMI TPA-R-SE（ケーブル・テストおよびシンク・テスト用）

当社 HDMI TPA-R-TDR（TDR テストおよびシンク・テスト用）
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ソフトウェアのインストール

ソフトウェアの起動

TDSHT3 ソフトウェアを起動するには、
次の手順に従ってください。

1. TDS7000 シリーズのオシロス
コープの場合は、File > Run
application > HDMI Compliance
Test Software(1.3)の順に選択しま
す。

2. TDS B シリーズおよび TDS C シ
リーズのオシロスコープの場合
は、App > HDMI Compliance Test
Software(1.3)の順に選択します。
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ソフトウェアのインストール

3. DPO70000 シリーズおよび
DSA70000 シリーズのオシロス
コープの場合は、Analyze > HDMI
Compliance Test Software(1.3)の順
に選択します。

4. オシロスコープ表示が、スクリーン
の上側に収まるようにサイズ変更
されます。

5. ディスプレイの下側にソフトウェア
が表示されます。

注： 正確な結果を得るために、テストを実行する前にプローブとオシロスコープを校正してください。
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ソフトウェアのインストール

プローブとオシロスコープの校
正

6. Utilities > Instrument Calibration の
順にクリックし、信号パスを補正す
るためにオシロスコープの校正を
開始します。

7. Calibrate をクリックします。

8. Vertical > Probe Cal の順に選択
し、プローブの校正を開始します。

9. プローブ校正信号をプローブに接
続します。

10.Calibrate Probe をクリックします。
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ソフトウェアのインストール

ソフトウェアの終了

1. File > Exit の順に選択します。

2. 終了アイコンをクリックして終了す
ることもできます。

これ以外の方法でソフトウェアを
終了すると、異常終了する場合が
あります。

3. ソフトウェアの終了時に、TDSHT3
ソフトウェアによって変更されたオ
シロスコープの設定を元に戻すこと
ができます。
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ソフトウェアの概要

ソフトウェアの概要

インタフェースの使用
TDSHT3 ソフトウェアでは、キーボード、マウス、またはタッチ・スクリーンで選択操作を行えます。

ソフトウェアの機能を使用するには、メニュー、チェック・ボックス、および画面上のボタンを使用します。
メニューを選択したりチェック・ボックスをオンまたはオフにしたりする場合は、Microsoft Windows の
操作方法に従います。

仮想キーボード

1. New をクリックします。

2. 表示されているテキストをクリアし、
新しいテキストを入力します。

3. Enter キーをクリックし、選択内容
を確定します。

注： 仮想キーボードの Enter キーをクリックするまで、選択内容は有効になりません。
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ソフトウェアの概要

仮想キーパッド

1. 目的の数値ボックスをクリックしま
す。

2. キーパッド・アイコンをクリックしま
す。

3. 表示されている値をクリアし、目的
の値を入力します。

4. 測定の単位を選択します。

5. Enter キーをクリックし、選択内容を
確定します。

注： 仮想キーパッドの Enter キーをクリックするまで、選択内容は有効になりません。
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ソフトウェアの概要

汎用ノブ

1. 目的の数値ボックスをクリックし、汎
用ノブとの関連付けを表示します。

2. オシロスコープの前面パネルにあ
る対応するノブを回し、選択したパ
ラメータの値を調整します。

3. 分解能を向上させるには、FINE ボ
タンを押します。
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ソフトウェアの概要

基本機能の設定

1. TDSHT3 ソフトウェアのメニュー・
バーから、File > Preferences の順
にクリックし、オプションを選択しま
す。

2. 選択内容をクリアする場合は、オプ
ションをもう 1 度クリックします。

オプション 説明

Position Eye Mask in Center これを選択すると、Eye Diagram の中央にマスクが配置されます。
選択を解除すると、Eye Diagram の左側にマスクが配置されます。

Acquisition Alert Message これを選択すると、アラートが表示されて、テストを実行するオシ
ロスコープの設定を指定するように要求されます。
選択を解除すると、TDSHT3 ソフトウェアが自動的にオシロス
コープの設定を選択します。

Jitter Tolerance（No calibration） これを選択すると、アプリケーションは、シンク・ジッタ公差測定
のためのジッタ校正を実行しません。
選択を解除すると、アプリケーションは、シンク・ジッタ公差測定
のためのジッタ校正を実行します。

Single Ended (With 50 ohm term) このオプションは、プローブのマイナス入力が50Ωターミネー
ションで終端されている場合にのみ選択できます。

これを選択すると、50Ωターミネーションが接続されているかの
ように、アプリケーションがシングルエンド測定を実行します。
選択を解除すると、アプリケーションは、50Ωターミネーションな
しでシングルエンド測定を実行します。

Set the probe control to internal 3.3V このオプションは、DPO/DSA シリーズ・オシロスコープと P7313
型プローブを使用するソース測定に適しています。

これを選択すると、プローブ・コントロールが内部に設定され、電
圧が 3.3 V に設定されます。

選択を解除すると、プローブ・コントロールが Auto に設定され
ます。
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ソフトウェアの概要

TDSHT3 ソフトウェアの非表示と再表示

1. TDSHT3 ソフトウェアを最小化して
オシロスコープの表示を拡大する
には、"非表示"アイコンをクリック
します。

TDSHT3 ソフトウェアを再表示するに
は：

2. TDS7000 シリーズのオシロスコープ
の場合、APP ボタンを選択します。
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ソフトウェアの概要

3. TDS6000B/C シリーズおよび
TDS7000/B シリーズのオシロス
コープの場合は、App > Restore
Application の順に選択します。

4. DPO70000 シリーズのオシロスコー
プの場合は、Analyze > Restore
Application の順に選択します。
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TDSHT3 HDMI ソフトウェアの使用

TDSHT3 HDMI ソフトウェアの使用

テスト：操作手順
テストを実行する際は、手順 1 ～ 6 までの一連の操作手順に従ってください。これらの操作の詳細
については、この後のセクションで説明します。

1. テストを選択します。

2. テスト・パラメータを設定します。

3. 機器を接続し、設定します。

4. 波形を表示してテスト信号を検査
します。

5. テストを実行します。

6. テスト結果を分析します。

7. レポートを生成します。

注： 正確なテスト結果を得るためには、テストを実行する前にオシロスコープとプローブを校正してくださ
い。 (5 ページ 「プローブとオシロスコープの校正」 参照)。

テストの選択

1. Select をクリックします。

2. Source タブ、Sink タブ、または
Cable タブをクリックします。

3. テスト名の近くにマウスを移動し
て、テスト ID を表示します。この ID
は、HDMI コンプライアンス・テスト
仕様の Test ID に対応しています。

4. 実行するテストを選択します。

複数のテストを選択できますが、こ
れらはすべて同じ種類にする必要
があります。

5. 特定の種類のテストをすべて選択
するには、Select All をクリックしま
す。
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TDSHT3 HDMI ソフトウェアの使用

テスト・パラメータの設定

1. Configure をクリックします。

2. 必要に応じて、仮想キーボードま
たはオシロスコープの前面パネル
にある汎用ノブを使用して値を変
更します。

File メニューを使用すると、出荷時
のデフォルト値に戻したり、独自の
設定内容を保存して呼び出したり
できます。

機器の接続と設定

注： テストでリモート・コントロールを使用する場合は、オンライン・ヘルプのセットアップ・ダイアグラムにあ
る、E-net 接続を使用したテスト機器の接続方法を参照してください。この方法だけでなく、GPIB-B 接続を
使用することもできます。(33 ページ 「テスト機器のリモート・コントロールの有効化」 参照)。 テストの例
は、「測定例」のセクションに示されています。 (20 ページ参照)。

1. Connect をクリックします。

2. 画面上の指示に従って、テストす
るデバイスとテスト機器を接続し、
設定します。

3. More をクリックすると、選択したテ
ストに関するオンライン・ヘルプが
表示されます。このヘルプには、
セットアップ・ダイアグラムが含まれ
ています。セットアップ・ダイアグラ
ムに示されているように、テスト機
器を接続します。

4. 選択したテストで AWG/AFG およ
び DTG を使用する場合は、Signal
Sources を選択し、テスト機器を設
定します。 (33 ページ 「テスト機器
のリモート・コントロールの有効化」
参照)。
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TDSHT3 HDMI ソフトウェアの使用

波形の表示

1. View Waveform をクリックします（テ
ストによっては使用できないことが
あります）。

2. 画面上部の波形が、TDSHT3 ソフ
トウェアで表示される波形に似てい
ることを確認します。

表示された波形が似ていない場
合は、設定と接続を確認してくだ
さい。

テストの実行

1. Run Test をクリックします。

2. テストが実行され、プログレス・イン
ジケータが表示されます。
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TDSHT3 HDMI ソフトウェアの使用

テスト結果の分析

1. テストが完了すると、テスト結果の
サマリが表示されます。デバイス
がテストに合格したかどうかを確認
します。

合格

不合格

エラー

デバイスがテストに合格しなかった
場合、 2から 8までの手順に従っ
て問題を解決し、もう 1 度テストを
実行します。

2. Result Details をクリックすると、テ
スト結果の詳細がスプレッドシート
形式で表示されます。

3. Remarks の列を確認します。エ
ラー・コードが表示されている場合、
オンライン・ヘルプでそのエラー・
コードの説明を参照してください。

注： Result Details ダイアログ・ボックスのパラメータは、実行するテストによって異なります。
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TDSHT3 HDMI ソフトウェアの使用

Data Lane で選択したオプション
（CK-D0、CK-D1、または CK-D2）に
応じて、対応するアイ・ダイアグラムが
表示されます。CK-D0 を選択した場
合の例を図に示します。

Eye Diagram テストを実行した場合は、
プロットが表示されます。この画面では
次の操作を実行できます。

4. 画像を C:\TekApplications\TD-
SHT3v1-3\Images に保存します
（このパスは変更可能です）。

5. 拡大または縮小します。

6. ヒストグラムを表示します。

7. マスクを移動して、誤差の範囲を
確認します。

8. 統計情報を表示します。

9. プロットを 1/2 スクリーン・サイズに
変更します（テスト結果のサマリが
表示されます）。

10.クロック・ジッタ・テストを実行した場
合にもプロットが表示されます。こ
のプロットでは、クロックのピーク・
ツー・ピーク・ジッタが表示されま
す。
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TDSHT3 HDMI ソフトウェアの使用

レポートの生成と印刷
以下に説明する方法で、サマリ・レポートまたは詳細レポートを生成し、印刷できます。

サマリ

1 つまたは複数のテストが正常に終了すると、レポート・サマリを CSV ファイルとして生成できます。

1. 実行ペインの Summary をクリック
します。

2. レポート・サマリが保存された場所
を示すメッセージが表示されます。

3. このファイルを開き、レポートを印
刷します。

詳細

テストの実行後に、デフォルトの情報や独自に設定した情報を含むレポートを生成できます。

1. Result をクリックし、レポートを設定
します（デフォルト設定を使用する
場合は、手順 8 にスキップしてく
ださい）。

2. デバイスの詳細を入力します。

3. テストを実行したときの分解能
（VGA、SVGA、XGA、SXGA、
1080i、1080p など）を入力します。

4. テストを実行したときのリフレッシュ・
レート（50 Hz または 60 Hz など）を
入力します。

5. 新しいレポートを生成するには、
Auto Increment を選択します。こ
のオプションを選択しても、既存の
レポートが上書きされることはあり
ません。

6. Save As をクリックして、生成された
レポートを保存します。Save File ダ
イアログ・ボックスが表示されます。
ファイル名を入力して、レポートを
保存します。

7. Clear Report をクリックし、すべて
のレポートをクリアします。今回の
テストで生成されたレポートの値が
クリアされます。
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TDSHT3 HDMI ソフトウェアの使用

8. レポート・ペインの Detail をクリック
し、HTML レポートを生成します。

プロットと波形が表示されます（該
当する場合）。

注： 生成された MHT ファイルは、Internet Explorer で開くことができます。
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測定例

測定例

Source: Select All（差動テスト）
この項目を選択すると、一連のテストが同時に実行されます。

必要な機器 例

差動プローブ× 2 （4 つのチャンネル
を使用している場合は 4 つのプロー
ブ）、グランド・リード

当社の P7313SMA/P7350SMA 型（外部回路付属の
P7330/P7350/P7380/P7380SMA 型のみが古いフィクスチャで
使用可能）。

P7313SMA 型プローブ（DPO/DSA シリーズ）では、外部電源の
代わりに内部バイアス電圧を使用することができます。
当社部品番号 196-3469-00

3.3 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

EDID エミュレータ× 1 ET-EDID PCB（INFO）／ Silicon Image TE9100/Quantum
Data 882CA

入力アダプタ× 1 Efficere Technologies 社製品の ET-HDMI-TPA-P（推奨）

プローブ校正／デスキュー・フィクス
チャ

当社部品番号 067-1478-XX

1. Select をクリックします。

2. Source タブをクリックします。

3. Select All をクリックします。

4. Configure をクリックします。必要に
応じて、これらの値を変更します
（通常はデフォルト値のままでかま
いません）。
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測定例

5. Connect をクリックします。

6. 機器を接続し、設定します。

セットアップ・ダイアグラムに示
されているように、テスト機器を
接続します。

ソース DUT の出力を、最初に
サポートされるビデオ・フォー
マットに設定します。

EDID チップを持つ Efficere
EDID PCB を接続するか、EDID
エミュレータを必要な分解能に
設定します（EDID エミュレータ
のユーザ・マニュアルを参照）。
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測定例

7. View Waveform をクリックします。

TDSHT3 ソフトウェアで表示される
ものと似た波形がオシロスコープに
表示されることを確認します。表示
された波形が似ていない場合は、
設定と接続を確認してください。

正確な結果を得るために、テスト
を実行する前にプローブをデス
キューします。

8. Run Test をクリックします。

9. テストが完了したら、テスト結果を
確認します。 (16 ページ 「テスト結
果の分析」 参照)。

10.実行したテストに基づいたレポー
トを生成できます。 (18 ページ 「レ
ポートの生成と印刷」 参照)。

Sink: Min/Max-Diff Swing Tolerance テスト
このテストでは、最小レベルの TMDS 差動電圧をシンク・デバイスが正しくサポートすることを検査します。

必要な機器 例

デジタル・タイミング・ゼネレータ 当社の DTG5274 型（最大 2.7 Gb）／DTG5334 型（最大
3.4 Gb）、DTGM30 型出力モジュール付属

SMA ケーブル× 8 当社部品番号 174-1341-00、1 m または
当社部品番号 174-1428-00、1.5 m

5.0 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

入力アダプタ× 1 Efficere Technologies 社製品の ET-HDMI-TPA-P（推奨）
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測定例

1. Select をクリックします。

2. Sink タブをクリックします。

3. Min/Max-Diff Swing Tolerance を
選択します。

4. Configure をクリックします。必要に
応じて、これらの値を変更します
（通常はデフォルト値のままでかま
いません）。

5. 使用可能なオプションからパターン
を選択し、Outputs をクリックして、
DTG Outputs を設定します。

6. Connect をクリックします。
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測定例

7. 機器を接続し、設定します。

セットアップ・ダイアグラムに示
されているように、テスト機器を
接続します。

DTG とオシロスコープを接続し
ます。 (33 ページ 「テスト機器
のリモート・コントロールの有効
化」 参照)。

8. Run Test をクリックします。

9. 画面上に示される一連のメッセー
ジの指示に従います。

10.テストが完了したら、テスト結果を
確認します。 (16 ページ 「テスト結
果の分析」 参照)。

11.実行したテストに基づいたレポー
トを生成できます。(18 ページ 「レ
ポートの生成と印刷」 参照)。

注： シンク・テストまたはケーブル・テストを実行すると、GPIB バス・タイミングに関する警告が表示され
ます。バス・タイミング・パラメータが 2 μs に設定されている場合、OK をクリックして続行してください。
そうでない場合は、Cancel をクリックして、バス・タイミング・パラメータを変更してください。 (38 ページ
「GPIB バス・タイミングの設定」 参照)。

Sink: Jitter Tolerance テスト
このテストでは、最大許容 TMDS クロック・ジッタをデバイスがサポートすることを検査します。

必要な機器 例

デジタル・タイミング・ゼネレータ 当社のDTG5274 型（最大 2.7 Gb）／DTG5334 型（最大 3.4 Gb）、
DTGM30 型および DTGM32 型（AWG710/AWG710B/AFG3000
シリーズでのみ使用）出力モジュール付属

任意波形ゼネレータ 当社 AWG710 型、AWG710B 型、または AWG7102 型（個別
ジッタ挿入）

任意波形ファンクション・ゼネレータ 当社 AFG3102 型、AFG3022 型、AFG3252 型

SMA ケーブル× 12 当社部品番号 174-1341-00、1 m または
当社部品番号 174-1428-00、1.5 m
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必要な機器 例

ケーブル・エミュレータ× 1 CTS 1.3b1 と同じ

バイアス・ティー× 2 ミニ回路 ZFBT-4R2GW

5 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

入力アダプタ× 2 Efficere Technologies 社製品の ET-HDMI-TPA-P および
ET-HDMI-TPA-R

1. Select をクリックします。

2. Sink タブをクリックします。

3. Jitter Tolerance を選択します。

4. Configure をクリックします。必要に
応じて、これらの値を変更します
（通常はデフォルト値のままでかま
いません）。

5. 使用可能なオプションからパ
ターンとジッタ挿入の種類を選択
し、Outputs をクリックして、DTG
Outputs を設定します。

6. Connect をクリックします。
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7. 機器を接続し、設定します。

注： ダイアグラムの のマークは、
空いている差動 SMA プローブの入力
ポートなどのバイアスされた 50 Ωター
ミネーションへの接続を意味します。

ジッタ生成ブロックを使用して、
既知量のジッタを生成します（ク
ロック・ジッタ： 0.25 UI、データ・
ジッタ： 0.30 UI）。

校正するオシロスコープにテス
ト・フィクスチャを接続します。オ
シロスコープが、既知量のジッ
タと共にケーブルとテスト・フィク
スチャにより挿入されるデータと
クロック・ジッタを計算します。

8. 次のいずれかの方法で機器の接
続と設定を行います。

方法 1a：テスト分解能≤ 74.25 MHz
の DTG-AWG710/AWG710B の場
合

セットアップ・ダイアグラムに示
されているように、DTG および
AWG にテスト機器を接続しま
す。

テスト・フィクスチャを DUT に接
続する際は、テストするピクセ
ル・クロック・レート用として指定
されたケーブル・エミュレータ
を使用します。

「テスト機器のリモート・コント
ロールの有効化」の説明に従っ
て、DTG、AWG およびオシロス
コープを接続します。 (33 ペー
ジ参照)。

HDMI 入力信号を受信するよう
に DUT を設定します。
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方法 1b：テスト分解能 >74.25 MHz
の DTG-AWG710/AWG710B の場
合

セットアップ・ダイアグラムに示
されているように、DTG および
AWG にテスト機器を接続しま
す。

テスト・フィクスチャを DUT に接
続する際は、テストするピクセ
ル・クロック・レート用として指定
されたケーブル・エミュレータ
を使用します。

「テスト機器のリモート・コント
ロールの有効化」の説明に従っ
て、DTG、AWG およびオシロス
コープを接続します。 (33 ペー
ジ参照)。

HDMI 入力信号を受信するよう
に DUT を設定します。

方法 2：DTG-AFG3000 複合ジッ
タ挿入

セットアップ・ダイアグラムに示
されているように、DTG および
AFG にテスト機器を接続しま
す。

テスト・フィクスチャを DUT に接
続する際は、テストするピクセ
ル・クロック・レート用として指定
されたケーブル・エミュレータ
を使用します。

「テスト機器のリモート・コント
ロールの有効化」の説明に従っ
て、DTG、AFG およびオシロス
コープを接続します。 (33 ペー
ジ参照)。

HDMI 入力信号を受信するよう
に DUT を設定します。
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方法 3：すべての周波数の
DTG-AWG7102 複合ジッタ挿入

セットアップ・ダイアグラムに示
されているように、DTG および
AWG7102 にテスト機器を接続
します。

テスト・フィクスチャを DUT に接
続する際は、テストするピクセ
ル・クロック・レート用として指定
されたケーブル・エミュレータ
を使用します。

「テスト機器のリモート・コント
ロールの有効化」の説明に従っ
て、DTG、AWG7102 およびオ
シロスコープを接続します。
(33 ページ参照)。

HDMI 入力信号を受信するよう
に DUT を設定します。
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方法 4：すべての周波数の
DTG-AWG7102 個別ジッタ挿入

セットアップ・ダイアグラムに示
されているように、DTG および
AWG7102 にテスト機器を接続
します。

テスト・フィクスチャを DUT に接
続する際は、テストするピクセ
ル・クロック・レート用として指定
されたケーブル・エミュレータ
を使用します。

「テスト機器のリモート・コント
ロールの有効化」の説明に従っ
て、DTG、AWG7102 およびオ
シロスコープを接続します。
(33 ページ参照)。

HDMI 入力信号を受信するよう
に DUT を設定します。

9. Run Test をクリックします。

10.画面上に示される一連のメッセー
ジの指示に従います。

11.テストが完了したら、テスト結果を
確認します。 (16 ページ 「テスト結
果の分析」 参照)。

12.実行したテストに基づいたレポー
トを生成できます。 (18 ページ 「レ
ポートの生成と印刷」 参照)。

注： シンク・テストまたはケーブル・テストを実行すると、GPIB バス・タイミングに関する警告が表示され
ます。バス・タイミング・パラメータが 2 μs に設定されている場合、OK をクリックして続行してください。
そうでない場合は、Cancel をクリックして、バス・タイミング・パラメータを変更してください。 (38 ページ
「GPIB バス・タイミングの設定」 参照)。

Cable: Eye Diagram テスト

ケーブル・イコライザ

通常の受動銅線ケーブルの信号劣化は、周波数とケーブルの長さによって増長します。このようなケーブ
ルからデータを再生するには、TDSHT3 では、クロック周波数が 165 MHz 以上の場合に、HDMI 仕様 1.3
で示されているようにリファレンス・ケーブル・イコライザを Eye Diagram 測定に適用します。

このテストでは、ケーブル部品から規格に合ったデータ・アイが出力されることを検査します。
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必要な機器 例

デジタル・タイミング・ゼネレータ 当社の DTG5274 型（最大 2.7 Gb）／DTG5334 型（最大
3.4 Gb）、3 つの DTGM30 型および DTGM32 型（AFG3000 シ
リーズでのみ使用）出力モジュール付属

差動プローブ× 2、グランド・リード 当社 P7313SMA 型； 当社部品番号 196-3469-00

任意波形ファンクション・ゼネレータ 当社 AFG3102 型、AFG3022 型、AFG3252 型

SMA ケーブル× 8 当社部品番号 174-1341-00、1 m または
当社部品番号 174-1428-00 1.5 m

3.3 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

入力アダプタ× 2 Efficere Technologies 社製品の ET-HDMI-TPA-P および
ET-HDMI-TPA-R

1. Select をクリックします。

2. Cable タブをクリックします。

3. Configure をクリックします。必要に
応じて、値を変更します（通常はデ
フォルト値のままでかまいません）。

Test Points 。テストする最初の
ケーブルでは入力テスト信号
（TP1）とケーブル出力（TP2）の
両方を検査するため、TP1 と
TP2 を選択します。この後の
ケーブル・テストでは、TP1 の選
択を解除してください。

CRU。コンプライアンス・テスト
用に PLL（デフォルト）が選択さ
れていることを確認します。
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4. DTG Method タブをクリックします。

使用可能なオプションからパ
ターンとジッタ挿入の種類を選
択します。

クロックとデータの入力信号を
生成する DTG 出力を設定しま
す。

5. Cable Equalizer タブをクリックして、
設定オプションを選択します。

6. Rise Time Filter タブをクリックして、
設定オプションを選択します。

7. Connect をクリックします。
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8. テスト信号入力を検査する機器を
接続し、設定します。

TP1 セットアップ・ダイアグラム
に示されているように、テスト機
器を接続します。

DTG とオシロスコープを接続し
ます。 (33 ページ 「テスト機器
のリモート・コントロールの有効
化」 参照)。

注： ダイアグラムの のマーク
は、50 Ωターミネーションまたは使用さ
れていないプローブ入力を示します。

注： シンク・テストまたはケーブル・テストを実行すると、GPIB バス・タイミングに関する警告が表示され
ます。バス・タイミング・パラメータが 2 μs に設定されている場合、OK をクリックして続行してください。
そうでない場合は、Cancel をクリックして、バス・タイミング・パラメータを変更してください。 (38 ページ
「GPIB バス・タイミングの設定」 参照)。

32 TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル



測定例

9. Run Test をクリックします。

10.画面上に示される一連のメッセー
ジの指示に従います。

11.テストが完了したら、テスト結果を確
認します。これらのテスト結果から、
テスト信号入力が規格に準拠して
いることが立証されます。 (16 ペー
ジ 「テスト結果の分析」 参照)。

12.TPA-P-DI アダプタを取り外し、
セットアップ・ダイアグラムに示され
ているように TPA-R-DI アダプタ
を取り付けます。

注： ダイアグラムの のマーク
は、50 Ωターミネーションまたは使用さ
れていないプローブ入力を示します。

13.ケーブル DUT を TPA-R-TDR の
アダプタ間に追加します。

14.Run Test をクリックします。

15.テストが完了したら、テスト結果を
確認します。合格した場合、ケーブ
ル DUT が HDMI に適合している
ことを意味します。 (16 ページ 「テ
スト結果の分析」 参照)。

16.Configure をクリックし、Test Points
を TP2 に設定します。

17.別のケーブル DUT に交換し、Run
Test をクリックします。

18.実行したテストに基づいたレポー
トを生成できます。 (18 ページ 「レ
ポートの生成と印刷」 参照)。

テスト機器のリモート・コントロールの有効化
当社指定の DTG モデルと AWG モデルを使用する場合は、テストを実行する際に接続されたテスト機器
を TDSHT3 ソフトウェアで自動的に設定できます。指定以外の DTG または AWG を使用する場合は、
テスト機器を手動で設定する必要があります。

次の方法で行います。

AWG と DTG をリモート・コントロール用に接続する

GPIB アドレスをリモート・コントロール用に設定する

次の機器が必要です。
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当社 DTG5274 型または DTG5334 型および当社 AWG710 型、AWG710B 型または AFG3000 型（2
チャンネル・モデル）または AWG7102 型または AWG7102

当社 TDS7000 シリーズのオシロスコープ、DPO70000 シリーズのデジタル・オシロスコープ、または
DSA70000 シリーズのデジタル・オシロスコープ

National Instruments GPIB-USB-B および添付ソフトウェア NI-488.2 for Windows

TDS シリーズ用の NI-488.2 ソフトウェア設定

注： オシロスコープにすでに NI-488.2 がインストールされている場合、手順 1 に説明されているバージョン
がインストールされ、インストール・パラメータが設定されていることを確認してください。正しくインストールさ
れていない場合は、NI-488.2 をアンインストールし、手順 1 に従ってインストールしてください。

1. NI-488.2 for Windows （バージョン
2.1 以上）をインストールします。

インストール時：

2. NI-VISA はインストールしないで
ください。

3. Measurement & Automation
Explorer をインストールします。

4. メッセージが表示されたら、
GPIB-USB インタフェースを有効
にします。

5. オシロスコープを再起動します。

DPO70000/DSA70000 シリーズ用の NI-Software 設定

注： DPO70000/DSA70000 シリーズ用の NI ドライバを初めて使用する場合は、手順 6 から 14までを実行
してください。そうでない場合は、手順 12 から 14までを実行してください。
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6. オシロスコープのメニューで、
Utilities > GPIB Configuration の順
にクリックします。

7. GPIB 設定で、Controller を選択し
ます。GPIB Mode Switch ダイアロ
グ・ボックスが表示されます。

8. OK をクリックして、オシロスコープ
を再起動します。
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9. オシロスコープのメニューで、
Utilities > GPIB Configuration の順
にクリックします。

10.GPIB 設定で、Talk/Listen を選択
します。GPIB Mode Switch ダイアロ
グ・ボックスが表示されます。

11.OK をクリックして、オシロスコープ
を再起動します。

Start > Program メニューから
は NI ソフトウェアにはアクセ
スできません。その代わり、
C:\Program Files\National

Instruments\NI-488.2\Bin に
移動します。

12.Add GPIB Hardware をダブルク
リックすると、Add GPIB Hardware
Wizard が表示されます。

13. リストから適切な NI ハードウェアを
選択します（接続されている場合
は、リストから GPIB-USB-B を選択
します）。

14.Next をクリックしてインストールを
完了します。

注： DPO70000 シリーズまたは DSA70000 シリーズのオシロスコープには最初から NI ドライバがインス
トールされていますので、さらにインストールする必要はありません。

36 TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル



測定例

機器の接続

15.USB-GPIB コントローラをオシロス
コープの USB ポートに接続しま
す。オシロスコープのオペレーティ
ング・システムが USB-GPIB コント
ローラを検出し、そのコントローラ
用のドライバをインストールします。

16.GPIB ケーブルを使用して、DTG コ
ネクタと AWG/AFG GPIB コネクタ
を GPIB コントローラの GPIB ポー
トに接続（スタック接続）します。

テストで AWG/AFG を使用しない
場合は、スタックされたコネクタを
AWG/AFG から取り外し、オシロス
コープと DTG 間を GPIB-USB-B
で接続します。

機器接続の確認

17.NI-488.2 ソフトウェアと共にイ
ンストールした Measurement &
Automation Explorer を開きます。

18.Configuration ペインの Devices and
Interfaces で、GPIB デバイスを右ク
リックします。

19. Scan for Instruments をクリックしま
す。

20.GPIB 機器番号とプライマリ・アドレ
スを確認します。

21.機器を右クリックし、Communicate
with Instrument をクリックします。

22.Query をクリックし、*IDN? に正し
い機器が表示されていることを確
認します。
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GPIB バス・タイミングの設定

23.GPIB デバイスを右クリックし、
Properties をクリックします。

24.Advanced タブをクリックします。

25.バス・タイミング・リストから、2 μs を
選択します。

26.OK をクリックします（手順 38 まで
の手順をすべて完了し、ソフトウェ
アを終了してオシロスコープを再起
動してください）。
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GPIB アドレスの設定

27.TDSHT3 ソフトウェアを起動します。

28. Select をクリックします。

29. Sink タブをクリックします。

30. Jitter Tolerance などの差動テスト
を選択します。

31.Connect をクリックします。

32. Signal Sources をクリックします。

Tektronix DTG5274 型または
DTG5334 型ゼネレータに対して次の
操作を実行します。

33.DTG タブをクリックします。

34.GPIB をクリックします。

35.AWG タブをクリックし、同様に
GPIB をクリックします。

36.AFG タブをクリックし、操作を繰り
返します。

37.Test Conn をクリックし、正常に接
続されたことを示すメッセージを確
認します。

38.TDSHT3 ソフトウェアを終了し、オ
シロスコープを再起動します。
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